Microsoft Application Series

PowerPoint 2010
Introduction

Best STL
- Courses never cancelled: Guaranteed
- Last minute rescheduling
- 24 months access to Microsoft trainers
- 12+ months schedule
- UK wide delivery

www.microsofttraining.net

Rev. 1.1
Microsoft Office PowerPoint 2010 Introduction

Your Best STL Learning Tools

Welcome to your Best STL training course.
As part of your training, we provide you with the following tools and resources to support and enhance your learning experience.

Thank you for choosing Best STL.

1. **In-course handbook**
   - To guide you through your training while you are on the course.
   - Contains unit objectives, exercises and space to write notes.

2. **Reference material**
   - Available online through your delegate account.
   - Comprehensive reference material with 100+ pages, containing step-by-step instructions.

3. **12 months access to Microsoft trainers**
   - Available through online support forum.
   - Need help? Our team of Microsoft qualified trainers are on hand to offer advice and support.

4. **Delegate account**
   - Your delegate account gives you access to:
     - Reference material
     - Course exercise files
     - Advice & support forum
     - Rewards programme
     - Promotions & Newsletters

5. **Trainer hints and tips**
   - Hints and tips available online from our Microsoft qualified trainers for:
     - All MS Office applications
     - VBA
     - MS Project
     - MS Visio
     + more

6. **Save with Promotions**
   - Save on further training courses you book with Promotions.
     - 30% off list price (time limited)
     - £50 off list price (blue card discount)

Tel: 0207 987 3777  
www.microsofttraining.net
# Contents

- **Opening Microsoft PowerPoint** .......................... ................................................... 7  
  *Open a Presentation* ................................................................. 7

- **Interacting with PowerPoint** .......................... ................................................... 8  
  *The View Toolbar* ................................................................. 9
  *Using the Slides Tab* ............................................................... 9
  *Using the Outline View* .......................................................... 10

- **Closing PowerPoint** ................................................................. 10
- **Closing Presentation** ................................................................. 10
- **Minimise Ribbon** ................................................................. 10

- **Getting Help in PowerPoint** ................................................... 11  
  *About Online Help* ................................................................. 11

- **Unit 1 Practice Activity** ................................................................. 11

- **Unit 2: Building New Presentations** ................................................... 13  
  *Creating a New Presentation* ....................................................... 14  
  *Adding a New Slide* ................................................................. 14
  *Deleting a Slide* ................................................................. 14

- **Editing a Slide** ................................................................. 15  
  *Creating Text* ................................................................. 15
  *Cutting, Copying and Pasting Text* ................................................... 15
  *Using the Format Painter* .......................................................... 15
  *Text AutoFit* ................................................................. 15
  *Clipboard* ................................................................. 16

- **Cutting, Copying and Pasting Slides** .......................... ................................................... 16

- **Reusing Slides** ................................................................. 16

- **Slide Outline** ................................................................. 17

- **Saving a Presentation** ....................................................... 18  
  *Save* ................................................................. 18
  *Save As* ................................................................. 18

- **Unit 2 Practice Activity** ................................................................. 19

- **Unit 3: Formatting and Proofing** ................................................... 20  
  *Formatting* ................................................................. 21
    *Font* ................................................................. 21
    *Paragraph* ................................................................. 22

  *Bullets and Numbering* ....................................................... 23  
    *Adding Bullets/Numbers* ....................................................... 23
    *Customizing Bullets and Numbers* ................................................... 23
    *Removing Bullets and Numbers* ................................................... 23

  *Alignment* ................................................................. 24  
    *Using Justification* ................................................................. 24
    *Using Columns* ................................................................. 24
    *Changing Text Direction* .......................................................... 24

  *Proofing* ................................................................. 25  
    *Spell Check* ................................................................. 25
    *Using AutoCorrect* ................................................................. 25

- **Unit 3 Practice Activity** ................................................................. 26
# Microsoft Office PowerPoint 2010 Introduction

- **Removing Masters** .......................................................................................................................... 54
- **Unit 7 Practice Activity** .................................................................................................................. 55
- **Unit 8: Delivering Presentations** ..................................................................................................... 56
  - **SlideShow Ribbon** .......................................................................................................................... 57
  - **Start Slide Show** ............................................................................................................................. 57
  - **Setup** ............................................................................................................................................ 57
  - **Print Preview** ................................................................................................................................. 58
    - **Opening Print Preview** .................................................................................................................. 58
    - **Using the Print What Option** ....................................................................................................... 59
  - **Web Features** ............................................................................................................................... 60
    - **Hyperlinks** .................................................................................................................................. 60
    - **Email Presentation** ..................................................................................................................... 60
    - **Saving a presentation as Webpage** ............................................................................................ 60
  - **Unit 8 Practice Activity** ............................................................................................................... 61
Unit 1: PowerPoint Basics

In this section you will learn how to:

- Open Microsoft PowerPoint
- Interact with Microsoft PowerPoint
- The View Toolbar
- Using the Slides Tab
- Using the Outline View
- Closing the Presentation
- Closing PowerPoint
Opening Microsoft PowerPoint

There are a number of ways to open the PowerPoint 2010 program.

Method 1: double click on PowerPoint 2010 Icon on your desktop

Method 2: If you cannot find the PowerPoint 2010 icon, click the Start button on the bottom left corner of your desktop to display the Start menu; then choose: Programs → Microsoft Office → Microsoft Office PowerPoint 2010.

Open a Presentation

In PowerPoint, open a presentation file by selecting the File Tab along the top of the Ribbons.

Click on File Tab in the upper left corner of the screen, select Open to browse the files collection, or select one of the recent used presentation files.

Try it: Open the presentation file Training.pptx
Interacting with PowerPoint

- **Microsoft Office Button**
- **Quick Access Toolbar**
- **PowerPoint Title Bar**
- **Window Control buttons** – minimize, maximize and close
- **Ribbon** - All commands for PowerPoint
- **Slide Pane** - Shows small image of each slide
- **Status Bar** - Extra information for the presenter
- **Notes**
- **Slide view**
- **Zoom Slider** - Zoom in and out of presentation
The View Toolbar

This toolbar is found at the bottom right corner of the PowerPoint window.

Default (Normal) view is the main editing view which lets you view individual slides and edit its content as well as its position. It divides the screen into: Outline tab, Slides tab, Slide pane and Notes pane.

Slide Sorter view uses thumbnails of the slides. This lets you see the content of each slide, makes it easy to reorder, add, or delete slides and preview your transition and animation effects. To move a slide, to a new position, just click and drag.

Slide Show view presents slides in a full screen mode. This helps you to preview the slides as the actual presentation slideshow with its settings (e.g. graphics, audio/video, timings, animated effects, slide transitions)

Reading View Use reading view to deliver your presentation not to an audience (via a large screen, for example), but instead to someone viewing your presentation on their own computer. Or, use Reading view on your own computer when you want to view a presentation not in full-screen Slide Show view, but in a window with simple controls that make the presentation easy to review

Using the Slides Tab

The Slides tab vertically displays thumbnail-sized images of the slides in the presentation.
Using the Outline View

The Outline view is an all text view showing the content of your presentation. As such, the Outline pane helps you edit your presentation’s content.

Closing PowerPoint

Click the X in the upper right corner of the PowerPoint screen or press key combination ALT + F4 on your keyboard.

Closing Presentation

Click the File Ribbon and select Close or press key combination CTRL + W on your keyboard.

Try it: Close the file Training.pptx

Minimise Ribbon

You can minimise the Ribbons across the top of the screen by clicking the in the top right of the screen.
Getting Help in PowerPoint

Microsoft PowerPoint provides a help screen where you can access online and offline help for any PowerPoint feature.

Click on the question mark at the top right hand corner of the window:

Click inside the Search box and type a search word or short phrase, and then press Enter:

After a moment of searching, you will see a list of relevant results listed. Click the title of any result to be shown its contents.

About Online Help

With Online help, you can access templates and training sessions regarding any topic by viewing content through your Internet connection.
Unit 1 Practice Activity

1. Start PowerPoint.
2. Open the presentation file Training.pptx.
3. Switch to Slide Sorter view.
4. Switch to Slide Show view.
5. Close the presentation file (you do not need to save changes).

Online support forum and knowledge base
www.microsofttraining.net/forum
Visit our forum to have your questions answered by our Microsoft certified trainers.
Unit 2: Building New Presentations

In this section you will learn how to:

- Creating a New Presentation
- Editing a Slide
- Cutting, Copying and Pasting Slides
- Reusing Slides
- Slide Outline
- Save a Presentation
Creating a New Presentation
Click on File Ribbon and Select **New**.
From the Screen displayed, Choose Blank Presentation, Create

You can also create a new workbook by using the shortcut keys **Ctrl + N**.

Adding a New Slide

To add a new slide, just click the **New Slide** command in the **Home** ribbon.

You may choose a specific slide layout as the list of choices descends from the New Slide button.

Deleting a Slide

Select slide in the Slide Pane and then press the Delete key on the keyboard.
Editing a Slide

Creating Text

Simply click inside a textbox / placeholder then start typing.

Cutting, Copying and Pasting Text

Select text to edit then, from the HOME ribbon, click on the cut or copy button. Pasting text will place the item in a new desired location.

Remember you can right-click selected text and click cut or copy, just like you can with slides. The Ctrl + X, Ctrl + C, and Ctrl + V keyboard shortcuts work the same as cut, copy, and paste, respectively.

Using the Format Painter

The Format Painter allows you to copy the formatting of text or shapes.

Select the original text / shape → click on Format Painter → Highlight the destination text/shape.

You can use the Format Painter more than once. Select the original text / shape → double-click on Format Painter → apply onto destination text / shape → click on Format Painter once more to disengage.

Text AutoFit

PowerPoint resizes text as you type to fit in a placeholder. Both font size and line spacing will be adjusted until all the text fits (to a minimum font size of 8 points). You may see click to switch on the options of the AutoFit to adjust text appearance on the slide.
Clipboard

The Clipboard is the first group, or “chunk,” on the Home ribbon. The Clipboard is associated with cut, copy, paste and the Format Painter. Cut and copied items are stored in the Clipboard, a UNIT of the computer’s memory.

You will notice a small icon in the lower right-hand corner of the Clipboard chunk. Click this button to open the Clipboard task pane, a listing on the left side of the screen that shows the last 24 cut/copied items from any Microsoft Office 2010 program that is open:

Cutting, Copying and Pasting Slides

Select the slide in the Slide Pane and then click Cut ( ) to cut the slide completely out of the presentation or Copy ( ) to duplicate the slide. After you have chosen to cut or copy, click in the Slide Pane where you want the slide to go and click Paste.

To move a slide’s position, just simply drag it in between two slides in the Slide Pane.

There are two shortcuts you can use to perform cut, copy, and paste operations. You can right-click on a slide in the Slide Pane to see these commands:

You can also use keyboard shortcuts.
- To cut something, highlight it and press Ctrl + X.
- To copy, Ctrl + C.
- And to paste, Ctrl + V.
Reusing Slides

You may reuse slides from existing files to save time in duplicating slides.

In the Home ribbon, click on **New Slide → Reuse Slides** (last option)

Then in the Task Pane (right side of Window) → select **Browse File** → choose the file and slides to be inserted.

Slide Outline

Use the outline view to organise the text content in each slide. As you right click on the selection of text, a list of outline options appear.

**Promote** raises the item level of a list. For a level one item, it will be promoted as a new slide.

**Demote** descends the item level of a list.
Saving a Presentation

Save

This allows you to update any changes within the presentation file.

Click on the **Save** icon on the Quick Access toolbar or press Ctrl + S to save any file updates. You may also find Save Command in the File Ribbon.

Save As

This allows you to save an extra copy of the file with the changes on file name, folder location and file type.

Click File Ribbon, select **Save As**. The Save dialog will display.

Select a location and name.
Unit 2 Practice Activity

1. Create a new blank presentation.
2. Ensure the first slide is in “Title Slide” layout, add title text “Outlander Spices” with a subtitle of your name.
3. Insert new slides by reusing the file Presentation.pptx – slides 2 and 3.
4. Save the presentation as My practice presentation.
5. Insert another new slide by reusing the file Progress Report.pptx – slides 5, as the final slide of your presentation.
6. Update the file.
7. Switch to Slide Sorter view.
8. Move slide 3 before slide 2.
9. Update and close the presentation.

Online support forum and knowledge base
www.microsofttraining.net/forum
Visit our forum to have your questions answered by our Microsoft certified trainers.
Unit 3: Formatting and Proofing

In this section you will learn how to:

- Formatting
- Bullets and Numbering
- Alignment
- Proofing
Formatting

Font

Select text then select the formatting tools from the HOME ribbon, or right click on your selection to bring up the toolbar.

Font

Click the pull-down arrow to choose a new font.

Font size

Choose from a number of specified sizes, or click in the text box and enter your own desired size.

Font larger

Incrementally increases font size.

Font smaller

Incrementally decreases font size.

Clear formatting

Removes any formatting applied to a font.

Bold

Makes text **bold**.

Italic

Makes text *italic*.

Underline

Underlines text.

Strikethrough

Draws a line through text.

Text shadow

Draws a shadow underneath the text.

Character spacing

Adjusts space between each character.

Change case

Make a selected block of text all upper or lower case.

Font color

Change the color of the font.
Paragraph

The Paragraph group on the Home ribbon displays the common paragraph commands such as bullets and numbering, indenting, justification, line spacing, etc.

Bullets
- Inserts a bulleted list.

Numbered list
- Inserts a numbered list.

Decrease indent level
- Decreases the indent of a paragraph by one tab space.

Increase indent level
- Increases the indent of a paragraph by one tab space.

Line spacing
- Specify the space between lines of text.

Text direction
- Turn the text a degree of rotation.

Align text
- Change how text is aligned in the text box.

Convert to SmartArt
- Change a list of information into a SmartArt diagram.

Left justify
- Aligns text to the left margin.

Center
- Centers text in the page.

Right justify
- Aligns text to the right margin.

Justify
- Aligns text to the left and right margins, equally spacing out text.

Columns
- Split a text area into two or more columns.
**Bullets and Numbering**

Items in a list may be highlighted with either bullets (i.e. small symbols or pictures) or numbers (i.e. numbers or alphabets).

**Adding Bullets/Numbers**

Most content slide layouts are formatted with standard bullets. You may change the bullet style from the **Home** ribbon.

Select the bullet icon and pick your choice from the bullet gallery;

or

Select the bullet icon and pick your choice from the number gallery.

**Customizing Bullets and Numbers**

Bullets and numbers can be customized in regards to size, style and color.

Click at the bottom of the gallery to open the bullets and numbering dialogue box.

**Removing Bullets and Numbers**

Select your item list and click on the bullet / numbering icon once to remove the bullet/number.
Alignment

Text can be aligned within a text box or placeholder. There are three standard alignments (Left, Right and Centre) and other text arrangements including justification, columns, and changing text direction.

Using Justification

Justification aligns text to the left and right, applying the right amount of space between words.

Using Columns

Using columns will give the presentation a newsletter appeal, and decrease the amount of slides you would have to use.

Highlight the text, from the Column icon, select the number of columns required. Click on More Columns to more options.

Changing Text Direction

Using text direction will let you rotate text 270°, 90°, or Stacked (which is vertical). Click on More Options (at the bottom) to opens the Format Text Effects dialogue box.
Proofing

Proofing tools can be found in the Review ribbon. You can also use a thesaurus, and research information.

Spell Check

Although you shouldn’t rely on the spell check to correct all of your typing errors, it does help with difficult spellings and some typos.

When PowerPoint doesn’t recognize a word it suggests several that are close in spelling.

Using AutoCorrect

The AutoCorrect feature fixes capitalization and spelling or typing errors that occur as you type any type of text except for WordArt.

AutoCorrect options are available in the application settings under Spelling and AutoCorrection.

To display the AutoCorrect, File Ribbon, Options (near the bottom). The Options dialog appears, Select the Proofing category (left side). AutoCorrect Options is at top on right hand side.
Unit 3 Practice Activity

1. Open **Outstanding issues.pptx**.
2. Make the title bold, increase the Font Size to 60, and change the Font of the title to another font type of your choice.
3. View the ruler, if necessary, and centre-align the text.
4. Check the spelling in the entire presentation.
5. If necessary, choose Help, show the Office Assistant.
6. Check the styles in the presentation.
7. Save the presentation as **My outstanding issues** and close the presentation.
8. Hide the Office Assistant, if necessary.

**Online support forum and knowledge base**

[www.microsofttraining.net/forum](http://www.microsofttraining.net/forum)

Visit our forum to have your questions answered by our Microsoft certified trainers.
Unit 4: Using Drawing Tools

In this section you will learn how to:

- Insert Shapes
- The Drawing Tool Ribbon
- Customize Shapes
Insert Shapes

From the Insert Ribbon, you will find the Shapes Gallery in the illustration group.

Select one shape and drag over to the middle of slide.

The Drawing Tools Ribbon

This ribbon only becomes available when the shape is selected. You may edit the shape, change its size / colour / outline / shape effects, add text and apply WordArt styles to the text.
Customize Shapes

When the shape is drawn, you may select the shape and rotate it by dragging the green circle above the shape, while the yellow diamond is used for reshaping its outline.

You may duplicate the shape by pressing CTRL + D.

After selecting a few shapes, you may group the selection as one object for further formatting. Right click the selection will bring up the menu, choose GROUP. Simply choose UNGROUP after editing to separate the shapes.
Unit 4 Practice Activity

1. Create a new blank presentation with a blank slide layout.
2. Select the Horizontal Scroll AutoShape (from the Stars and Banners submenu).
3. Drag to draw the AutoShape on the slide.
4. Add Explosion 2 and 5-Point Star AutoShapes (from the Stars and Banners submenu).
5. Draw an Oval by using the Drawing toolbar.
6. Add text to Objects as shown in the example below. Wrap the text where ever necessary.
7. Make the Web Initiatives text bold. Set the font size to 32.
8. Add different fill colours to the objects.
9. Resize objects wherever required.
10. Save the presentation as Web initiatives.
11. Close the presentation.

Online support forum and knowledge base
www.microsofttraining.net/forum
Visit our forum to have your questions answered by our Microsoft certified trainers.
Unit 5: Working with WordArt and ClipArt

In this section you will learn how to:

- Adding and Formatting WordArt
- Adding and Formatting ClipArt
Adding and Formatting WordArt

WordArt Styles can be found under **Drawing Tools** Ribbon.

You may choose the colour style, text colour, text outline and text effects from the WordArt Styles.

Adding and Formatting ClipArt

ClipArt can be added to any slide in PowerPoint. ClipArt ranges from clips and graphics to movies and sound. All items can be found through the ClipArt task pane.

Insert and Formatting ClipArt

From the **Insert** ribbon, select **ClipArt** which opens the ClipArt task pane.

Enter a keyword for the kind of ClipArt you want, press **Go**. Click on the picture you wish to insert then customize the ClipArt by right clicking to bring up the menu.
Unit 5 Practice Activity

1. Create a new presentation starting with a blank slide.
2. Select a WordArt style of your choice.
3. Enter **Keys to our success**.
4. Resize the WordArt.
5. Move the WordArt to the centre of the slide.
6. Insert a new slide.
7. Select the Title, Content and Text layout.
8. Enter the title **Keys to our success**.
9. Insert clip art relating to **Business** as shown in the example below.
10. In the bulleted list, enter 5 bullets, as shown in the example below.
11. Compare your work to the example below.
12. Save the presentation as **My success**, then close the presentation.

**Keys to our success**

- Teamwork
- Dedication
- Innovation
- Commitment
- Loyalty

Online support forum and knowledge base

[www.microsofttraining.net/forum](http://www.microsofttraining.net/forum)

Visit our forum to have your questions answered by our Microsoft certified trainers.
Unit 6: Using Tables and Charts

In this section you will learn how to:

- Working with Table
- Working with Chart
- Working with SmartArt
Working with Table

Insert a Table

To create simple tables, use the **Insert Table** command on the **Insert** ribbon.

Inserting a basic table is easy, just open the slide you want to add the table to and click the table command. Hover over the size of table you want (like the 3x5 table below) and then click the bottom-right corner of the table to insert it.

Format a Table

When you select the table, **Design** Ribbon will switch on under Table Tools.

You can apply different Table Designs as well as WordArt Styles onto the text.
You may also manipulate with the table structure by using the tools in Layout Ribbon of Table Tools. Again, it is only available if you select the table.

![Table Tools](image)

### Changing the Shade of a Fill

Most fills used for tables are solid or gradient fills, but other shades can also be used. A shape is the actual cell of the table, therefore when applying fills the entire table (or particular cells) must be selected.

Under the Shape Fill command, you will find all of the gradient, texture, and picture options for table backgrounds.

![Shape Fill](image)

### Applying Borders

Select cells or the whole table then choose one of the border style from the Borders Gallery.

![Borders](image)
Working with Charts

PowerPoint 2010 gives you the ability to create your own graph or insert a graph from a file.

Creating and Linking Worksheet Charts and Graphs

To create a chart or graph, click **Insert ribbon → Chart → choose a chart type.**

It then opens an Excel worksheet where you can enter your chart's information.
Chart Tools Ribbon
You will see that PowerPoint has specific ribbons for the creation of charts. The Chart Tools Ribbon has three sub-ribbons: Design, Layout and Format.

Design Ribbon

Layout Ribbon

Format Ribbon
Legends and Labels

When working with charts, a legend will automatically be created for you. However, you are not required to use that particular legend. You can change the legend using the Legend, Data Labels, and Axis Titles options of the Chart Tools → Layout ribbon. Each function provides standard and advanced legend and label options.

Legends are the column headings you use in the Excel worksheet, and can be hidden or customized using the Legends and Labels command on the Layout ribbon.

Data labels are the subject titles used in the chart and can be hidden or customized using the Legends and Labels command on the Options ribbon.

Axis Labels are the labels applied to the X and Y axes.
Working with SmartArt

SmartArt is a new type of organization chart. Organization charts are different from a regular chart/graph because they show a hierarchical relationship. They can be used to display the chain of command at a corporation or the line of descent in a family tree.

Creating SmartArt

PowerPoint 2010 provides users with various styles of SmartArt so that you can decide which one will work best with your presentation and data. There are seven types of SmartArt available to choose from.

The first step in creating SmartArt is clicking Insert. Then, click SmartArt and choose your graphic type and click OK:
SmartArt Tools
The SmartArt tools ribbons provide commands to design and format each element of the SmartArt.

Design Ribbon

**Layouts** Choose a layout style to apply to your graphic. The basic structure will be kept the same, though the diagram will look like different physical effects have been applied.

**SmartArt Styles** Choose a different look and feel as well as color scheme.

**Reset** Returns your SmartArt to the default style when the diagram was first inserted.

Format Ribbon

**Shapes** You can physically edit the shape of each SmartArt shape with these commands.

Resizing Diagrams

Once you have decided on the look of the SmartArt you want to use, you can modify the size of the chart as a whole. In order to resize your chart you must first select the chart by clicking the border surrounding the entire graphic. Then, you must click and drag the outside border of the chart to the new size.
Unit 6 Practice Activity

1. Create a new blank presentation with a Title and Table layout slide.
2. Type Sales (in Pounds) in the title placeholder.
3. Add a 5-column by 4-row table to the slide.
4. Complete the table, as shown in Example 1 below.
5. Add another slide containing a title and a chart.
6. Replace the row headings with text in the first column in the table.
7. Replace all values in the datasheet with the values in the table cells.
8. Add another slide containing an organisational chart
9. Create levels and add text, as shown in Example 2 on the next page.
10. Change the colour of all boxes to yellow.
11. Compare your chart to Example 2 on the next page.
12. Run the presentation.
13. Save the presentation as **My sales** and close it.

<table>
<thead>
<tr>
<th></th>
<th>1st Qtr</th>
<th>2nd Qtr</th>
<th>3rd Qtr</th>
<th>4th Qtr</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cumin</td>
<td>30</td>
<td>45</td>
<td>45</td>
<td>30</td>
</tr>
<tr>
<td>Thyme</td>
<td>50</td>
<td>80</td>
<td>80</td>
<td>60</td>
</tr>
<tr>
<td>Oregano</td>
<td>85</td>
<td>60</td>
<td>60</td>
<td>75</td>
</tr>
</tbody>
</table>

Example 1
The Project Team

Kathy Sinclair
President

Ann Salinski
VP Financial Services

Jack Thomas
VP Sales

Susan Gianni
Business consultant

Solena Hernandez
Market Analysis

Aileen MacElvy
Marketing Manager

Ron Timmons
Senior Buyer

Example 2

Online support forum and knowledge base
www.microsofttraining.net/forum
Visit our forum to have your questions answered by our Microsoft certified trainers.
Unit 7: Enhancing Presentations

In this section you will learn how to:

- Using Templates
- The Design Ribbon
- The Animations Ribbon
- Introduction to Slide Masters
- Using Masters
Using Templates

Templates are files that are ready to use, you just need to add the information and change the template to suit your needs.

Opening a Template

When you click File Ribbon → New, you will see the New Presentation dialogue box appear. There are two categories to choose from; Recent, Sample and My Templates (ones that were installed when Office was installed) and those that are available from Office Online. When you have selected a file to use, click Create:

If you select a file from the Microsoft Office Online category, you must wait for the template to download first. (We will explore this in a moment.) Most of the templates are under a megabyte in size, so this process won’t take long.
Using a Template

Once a template is open in front of you, you can begin to use it as you would any file that was created from scratch:

You can change fonts, move objects, apply new slide styles and transition effects, etc. When you want to save changes, clicking Save will open the Save As dialogue box. Enter a location and name for the file and click OK to save it.

Downloading Templates

PowerPoint 2010 templates have the file extension *.potx, you can also use any template file that was created with Office 97-2003 (*.pot).

To download a template from Office Online, click Office Menu → New and then choose a category under the Office Online heading.
Creating a Template

If you want to create a template for your own use, or use an existing template and modify to suit your needs, simply click Office Menu → Save As.

When the Save As dialogue box appears, click the combo box beside Save as type and select PowerPoint Template from the list:

Give the template a name and the next time you want to use it, you can choose it from the list of available installed templates:
The Design Ribbon

The Design ribbon is all about themes and styles; the overall look of the slides. In this lesson we will look at the various designing options available to you through the Design ribbon.

Themes

Slide themes are built-in designs for presentations. Colors, fonts, effects, background color and graphics are already created in attractive color schemes to fit nearly every presentation. For the individuals who enjoy taking risks, each theme can be altered using the Colors, Fonts, and Effects commands:

Background

You can change the background effects of a slide using the Background Styles command. Just click the command and choose from an existing background for the slide. Applying a custom background is done by clicking Background Styles. The Hide background graphics is useful when you want to use the color scheme of a theme, but not the background graphics of that theme:

The Option button in this chunk will open the Format Background dialogue box, Fill tab. Choose your fill type, color, and transparency (we will explore more of these options later):
The Animations Ribbon
When you reach the Intermediate and Advanced levels of PowerPoint, you will start working with animations. Animations are effects that happen when one slide changes to the next.

Preview
Preview serves a useful and simple purpose – to show you what your animated slideshow will look like! Just click the Preview command to see, from a black screen, how your slide will appear during your actual presentation.

Slide Transition
Aside from the Animation schemes, you can also apply entrance effects to slides as a whole using Transition to This Slide command UNIT. PowerPoint has created a diverse gallery of slide transitions and offers tools for you to run an automated presentation. These tools consist of transition speed, sound, and timing options.

The last two commands on the right provide you with timing options one slide is to go to the other. Slides can go from one to the other automatically after (timing), or by a mouse click.

After you have applied an animation to a slide, you will see a small star appear beside the slide number in the Slide Pane:
Headers and Footers
You can apply headers and footers to your presentation. These can be applied to the slide show or the handouts.

Add Header or Footer
To add either Header and/or Footer click the Insert Ribbon, Header & Footer Button

The following dialog appears:

Select from the tabs across the top either Slide or Notes and Handouts

You can apply Dates (Fixed or Updated), Slide Number, or Footer text. Note: If you do not want the Header/Footer on any Title Slides tick the checkbox at the bottom (as indicated).

While setting the Header/Footer you can see on the small preview, bottom right of dialog box, where things will appear.
Introduction to Slide Masters

Master slides hold all design and layout elements of a presentation. Master slides should be used when dealing with numerous slides in a publication. Using a master slide will give you layout and design consistency. It will also cut down on editing time, as you will only have to edit the master slide, not each slide individually. Usually one master slide will be assigned to a publication; even when the publication consists of 12 slides, it will have one master slide. This does not mean that additional master slides cannot be added, in order to give the publication diversity. Master slides can be created, duplicated, converted, modified, and used for Web publications. In this lesson, we will focus on types of masters, and viewing slide, note and handout master ribbons.

Types of Masters

There are three different types of Masters: Slide masters, Note masters and Handout masters. Notes are created for the individual slides in the presentation, like handouts both types can be handed out during a presentation for viewers to take notes. All three masters can be viewed from the View Ribbon.
Using the Slide Master Ribbon

View this ribbon by clicking View → Slide Master. The Slide Master ribbon will have commands you are already familiar with, as they are found on the main PowerPoint Ribbons. The commands are centered on one ribbon to make editing easier:

- **Edit Master**: Use these commands to manage the master slides of your presentation. Delete, rename, add new layout elements, and more with these commands.
- **Master Layout**: Customize the elements included in your master slide by adding new placeholders, as well as adding or removing title and footer placeholders.
- **Edit Theme**: Customize the look of the master slide with these commands, using themes, colors, fonts, and object effects you are already used to using.
- **Background**: Add a background picture, texture, or gradient with the Background Styles command. You can also hide the background image which allows you to focus on managing the content of the master.
- **Page Setup**: Adjust the margins and page orientation here.

Let’s go over the commands in each section of the ribbon:
Create a Master Slide

Creating a Master slide can be creating masters from scratch, or simply changing an existing one. Slide Masters have default layouts; when Inserting new slide masters PowerPoint will insert the Master followed by the title page and the rest of the slides, some contain content or other placeholders. Each has a set layout which you can change using the Master Layout command, Insert Custom Layout command, and by inserting specific placeholders on slides. Each slide in the Master view represents the slide in normal view. For example, if you customize a title and content slide, that will be the Master for the title and content slides you insert.

When choosing Font styles, click the title placeholder on the Master and then choose the style, the rest of the slides will follow. When creating masters from scratch, the world is your oyster! This lesson shows you the basics of creating a Slide Master, but that does not mean that your slide masters need to be basic. Utilize the Slide Master tools, explore the Edit Master Ribbon and Drawing Tools contextual tab, you would be amazed at the masters you can create.
Using Masters

You can use and apply as many masters as you want for a single presentation, the key is you must save the themes and preserve the masters. In this lesson we will discuss how to apply Slide, Note, and Handout Masters.

Apply Master to a Slide

Once you have saved Master Themes, they will be available for use on any future presentation. You can also apply multiple masters to the same presentation. In order to do this, save the first Master theme, and then preserve the first Master.

Once this is done you can insert a New Master, customize it, and save the second Master theme.

When returning to Normal view, click Add Slide and both Master themes will be displayed, for you to apply to the presentation.

Removing Masters

Removing Masters is fairly simple, open the Slide Master view, click the Master you wish to remove, and in the Edit Master group, click Delete. Deleting a Master only deletes it from the presentation; it does not delete the theme, so you will be able to find it for future use.
Unit 7 Practice Activity

1. Open Progress to date.pptx.
2. Apply a design template of your choice.
3. Change the font of the Master Title Area to Arial Black.
4. Change the font of the Master Object Area to Arial Narrow.
5. Change the first level bullet style.
6. Save the presentation as My progress to date.
7. Add a new slide master of your choice.
8. Apply the new slide master to all the slides
9. Add transition effects.
10. Rehearse the timings.
11. Add speaker notes to slides 2 and 3.
12. Update and close the presentation.

Online support forum and knowledge base
www.microsofttraining.net/forum
Visit our forum to have your questions answered by our Microsoft certified trainers.
Unit 8: Delivering Presentations

In this section you will learn how to:

- SlideShow Ribbon
- Print Preview
- Using the Print Preview Toolbar
- Printing Your Presentation
- Web Features
SlideShow Ribbon

The Slide Show ribbon is for more advanced PowerPoint users. It allows you to start from different slides and create customs shows that link to two separate presentations simultaneously. You can also run self-maintained presentations with your voice narrating the entire piece and set up multiple monitors. Full usage of these commands requires a greater understanding of PowerPoint itself, so we will cover only the basics of these commands.

Start Slide Show

The Start Slide Show group has three commands: From Beginning, From Current Slide and Custom Slide Show. Custom Slide Show is where we create linked slide shows.

To start the slide show, click the Slide Show view button on the bottom right of the screen or select From Beginning from the Slide Show Ribbon. The first slide in the presentation appears in full screen, and will not proceed to the next slide until you choose to do so, or set timings for automatic navigation.

Setup

The Setup group allows you to run automatic presentations by using the Setup Slide dialogue, hide slides, rehearse timings, and include voice narrations.

For example, you can set up a presentation to run unattended in a booth or kiosk at a trade show or convention. A self-running presentation can restart when it's finished and also when it's been idle on a manually advanced slide for longer than five minutes.

When you run a presentation, you want to ensure that each slide is displayed for an appropriate amount of time. A slide that is displayed too long will quickly lose the viewers’ interest and if it is too brief there may not be time to read it all. These problems can be avoided by rehearsing slide timings.
Print Preview

When you are delivering a presentation, you may want to have printed copies of the slides to give to your audience. Previewing your presentation before you print handouts is a good habit to develop. This gives you an opportunity to fix any errors you may find and give the slides a final run-through. The Print Preview window has quite a few options to help you make your printed presentation as appealing as the slide show.

Opening Print Preview

From the File Ribbon Select the Print Option. The following dialog will appear where a Preview is shown on the right pane and options on the left.

Select from Settings: Which slides you want to print, What type of Print out, such as handouts or slides. Collated or printed in colour. Specify the number of copies required from the top, and which printer you want to send to. When all settings are completed, Click the Print Button as indicated above.
Using the Print What Option

As stated above the Print What menu displays all the possible handouts and notes pages you can print off. Print Preview will let you view each one before printing. Notes and handouts are great to use if your presentation is a lecture where the viewers are required to take notes.
Web Features
You may add hyperlinks to your presentation; email the file to a colleague and save the presentation as a Webpage.

Hyperlinks
Selecting a string of text or a picture, click Insert tab → Hyperlink. It brings up the hyperlink dialogue box for customizing the destination.

Email Presentation
Select the File Ribbon → Save and Send → Send using Email, then type in the recipient’s email address.

Saving a presentation as Webpage
Select the File Ribbon → Save and Send → Save for Web → You will require a web account so the file can be uploaded for sharing with others who can view the presentation through any web browser.
**Unit 8 Practice Activity**

1. Open *Products.pptx*.
2. Run the presentation.
3. Print the presentation (if you’re connected to a printer).
4. Switch to Normal view
5. In *Products.pptx*, add a hyperlink to the text:
   - Click here to learn more about us.
   - Link it to a web address.
6. Click the Hyperlink to load the Web page.
7. Close Internet Explorer (or other browser you use).
8. Close PowerPoint without saving the changes.

---

**Online support forum and knowledge base**

[www.microsofttraining.net/forum](http://www.microsofttraining.net/forum)

Visit our forum to have your questions answered by our Microsoft certified trainers.